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1 HOW TO USE THIS DOCUMENT 

1.1 SYMBOLS AND SIGNAL WORDS 

This manual uses the following symbols and signal words for information of importance. 

 DANGER 

Indicates a hazardous situation which, if not avoided, will result in serious injury or 

death. 

 

 WARNING 

Indicates a hazardous situation which, if not avoided, could result in serious injury 

or death. 

 

 CAUTION 

Indicates a hazardous situation which, if not avoided, could result in minor or 

moderate injury. 

 

 IMPORTANT 

Indicates information considered important but not directly hazard related (e.g., 

security, hygiene, equipment, or property damage). 
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Procedure 

Indicates a call to action. One or more steps to be executed are following this signal 

word. An exception has been made for warning notices, where this signal word has 

been omitted. 

1.2 NOTATION CONVENTIONS 

This manual uses the following notation conventions that are given in the following table. 

Notation conventions 

Notation Meaning 

Underlined click-able cross reference or hyperlink 

[⟨Number⟩] cross reference to a list of further reading on page 128 

Bold element in the graphical user interface that the user shall click 

Italic name of element in the graphical user interface or  

emphasized text 

Typewriter text to be typed in by the user, filename, or path 

1.3 STORAGE AND REPLACEMENT 

•  Keep this manual with the product to access it at any time during the product’s 

lifetime. 

•  A replacement for this manual can be requested. The manual is available as a PDF-file. 

•  This manual is part of the product. If the product ownership changes, then this 

manual must accompany the product. 
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1.4 SPECIFICS AND STRUCTURE 

Novanta reserves the right to update this manual at any time without prior notification. 

This manual is limited to installation and commissioning instructions, troubleshooting and 

maintenance. 

• Be mindful of the environment, do not print if you do not need to. 

1.5 TARGET AUDIENCE AND QUALIFICATION 

 IMPORTANT 

Only target audience, who are listed in the beginning of each instructing section in the 

following chapters, may perform the activities described there. 

 

The people who perform these activities need to be of age. 

The qualification of the target audience is defined below. 

Laymen 

without special qualification, who e.g., transport and store the boxed product. 

Operators 

who are trained by the company that is operating the laser unit, where the product is 

incorporated, in the use of that laser unit and who confirmed the training by 

signature. 

Experts 

in electrical engineering or mechatronics, who are successfully trained in handling 

highly sensitive electronic and optical equipment. Experts must be trained by the 

company that is operating the laser unit, where the product is incorporated, in the use 

of that laser unit, and must confirm this training by signature. 
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2 GENERAL SAFETY INSTRUCTIONS 

2.1 INTENDED USE 

• The scan head is delivered as an OEM component for integration into a laser unit that 

will be operated in a dry and clean indoor environment without electrically conductive 

contamination. 

• Customers must know and apply the rules and regulations for safe operation of lasers 

when installing and operating the scan head and the laser unit in which it is used. 

Since Novanta has no influence over the employed laser device or the overall laser 

unit, the customer is solely responsible for the safe operation of the laser unit. The 

laser unit manufacturer bears responsibility for complying with the standards and 

guidelines required for the CE (European Conformity) label. Please contact Novanta 

for further information about this scan head and applicable guidelines. 

• Before installing and operating the scan head, carefully read this manual for your 

protection. 

• Retain this manual for future reference. 

2.2 REASONABLY FORESEEABLE MISUSE 

It is considered a misuse if you use the scan head without incorporating it into a laser unit 

that complies with the standards required for the CE (European Conformity) label. 
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2.3 DUTY OF CARE BY THE CUSTOMER 

 IMPORTANT 

• Customers assume full responsibility for maintaining a laser-safe working 

environment. Original equipment manufacturer (OEM) customers assume full 

responsibility for CDRH (Center for Devices and Radiological Health) certification. 

2.4 HAZARDS 

2.4.1 LASER RADIATION 

The scan head is intended for use in combination with a class 4 laser. 

 WARNING 

Visible or invisible laser radiation can cause severe retinal and corneal burns, burns to the 

skin, and may pose a fire risk. 

• To avoid injury and reduce risk of fire, follow the control measures and safety 

guidelines provided by the laser’s manufacturer, and those established by your Laser 

Safety Officer (LSO), Radiation Safety Officer (RSO), or safety department of your 

business or institution. 

• The integrator must take appropriate protective measures to reduce the risks of 

exposure to laser radiation. 

• The integrator must take appropriate protective measures to reduce fire and 

explosion hazards of laser processed materials. 

2.4.2 LASER GENERATED AIR CONTAMINANTS 

During laser material processing, matter is evaporated. Laser generated air contaminants can 

compose of multitude hazardous products, such as nickel, chrome, alumina, zinc, butanol, 
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toluol, xylene, and formaldehyde. The concentration, size, and the quantity of these aerosols 

and particles can vary. 

 WARNING 

Laser generated air contaminants, even if respired in lowest concentrations over long time 

or brought to skin contact, can cause skin irritations, contact eczema, sickness, vomiting, 

cauterization of the respiratory tract, nervous diseases, allergic reactions, spasms, and 

cancer. 

• To avoid injury, follow the control measures and safety guidelines provided by the 

respective material safety datasheet, and those established by your Laser Safety 

Officer (LSO), Radiation Safety Officer (RSO), or safety department of your business or 

institution. 

• The integrator must take appropriate protective measures to reduce risks of exposure 

to dust and fumes from laser processing. 

2.4.3 BERYLLIUM MIRRORS 

The scan head contains beryllium mirrors. Under normal circumstances, i.e., if the housing 

and protective windows and the beryllium mirrors are undamaged and if the product is 

handled and used properly then the beryllium mirrors present no danger. Danger may only 

arise if the beryllium mirrors are damaged and the housing is not sealed according to degree 

of protection IP65, as the damage may have produced small quantities of beryllium dust that 

may not be visible. 
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 WARNING 

Beryllium is classified as carcinogenic substance of category 1B and hazard class STOT RE1. 

This applies especially to beryllium as dust or vapor, i.e., if the beryllium mirrors are 

damaged. Beryllium causes eczema, berylliosis and cancer when getting in contact with 

skin or inhaled. 

• DO NOT open the scan head. DO NOT remove the protective windows. 

• If the housing is not sealed according to degree of protection IP65 AND if the 

beryllium mirrors are damaged, then immediately follow the response procedure in 

section 8.2 on page 127. 

2.4.4 HOT LASER-PROCESSED MATERIAL 

During materials processing with lasers, strong heating of the processed material may arise. 

 CAUTION 

Hot laser-processed material can cause skin burns. 

• If you are a system integrator, then place a sign at the laser processing area that 

warns about hot surfaces. 

• When handling material by hand that was laser-processed shortly before then wear 

heat resistant protective gloves. 

2.4.5 COOLANT AND COOLANT ADDITIVES 

The scan head has a cooling loop and may use a special coolant or coolant additives, like 

calcination inhibitors, algae inhibitors, anti-corrosion, and anti-freeze agents. 
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 CAUTION 

Coolant or coolant additives might give rise, amongst other things, to allergies, eczema, 

and other irritations if they get in contact with the skin or mucous membranes. 

• To avoid injury, follow the control measures and safety guidelines provided by the 

respective material safety datasheet, and those established by your Laser Safety 

Officer (LSO), Radiation Safety Officer (RSO), or safety department of your business or 

institution. 

2.4.6 ELECTROSTATIC DISCHARGE 

The scan head contains parts that are sensitive to electrostatic discharge. 

 IMPORTANT 

Electrostatic discharge (ESD) can damage the scan head which is an electrostatic 

discharge-sensitive device. 

• Transport equipment only in anti-static packaging and packaging equivalent to that 

received with the shipment. 

• Keep the scan head sealed until within an ESD-controlled environment. 

 

A proper static control station should include: 

□  A soft grounded conductive tabletop or grounded conductive mat on the tabletop 

□  A grounded wrist strap with the appropriate (1 MΩ) series resistor connected to the 

tabletop mat and ground 

□  An adequate earth ground connection, such as an uncoated water pipe or AC ground 

□  Conductive bags, trays, totes, racks, or other storage 

□  Properly grounded power tools 

□ Personnel handling ESD items must wear ESD protective garments and ground straps 
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2.5 MODIFICATIONS AND SPARE PARTS 

Modifications to the scan head are not permitted. This includes but is not limited to water 

connectors. 

Spare parts specified, supplied, or approved by Novanta are only permitted for use with this 

scan head. 

2.6 FIRE EXTINGUISHER RECOMMENDATION 

Procedure 

• A carbon dioxide (CO2) fire extinguisher must be used. 

• Ensure the fire extinguisher used is compatible with the entire laser unit. 

•  Prior to installing the scan head, ensure the fire extinguisher is available and observe 

its instructions for use including its hazard notes. 
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3 OVERVIEW 

Firefly3D is a specialist scanning module designed with the additive manufacturing market in 

mind but can be deployed into other application domains equally effectively.  

The system incorporates measurement and synchronization capabilities that ensure additive 

manufacturing users can attain superior levels of process monitoring easily. In addition, 

Firefly3D and its complimentary controller, ScanMaster Controller, allow closed loop process 

control solutions to be developed with ease. 
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3.1 LABELS 

   

Figure 1: Position of labels 

 Legend to Figure 1 

No. Label Description 

1 

 

Type label 

2 

 

Warranty label 

             

                          

         

① 

② 

③ 

 

② 

② 
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No. Label Description 

3 

 

Warning of laser beam label 

3.2 INTERFACES 

 
 

Figure 2: Position of interfaces 

Legend to Figure 2 

No. Marking / function See section On page 

1 Monitoring port (1200–2000 nm) 4.3.10 53 

① 

② 

③ 

④ 

⑤ 
⑥ 

⑦ 

⑧ 

⑨ 

⑬ 

⑫ 

⑩ 

⑪ 
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No. Marking / function See section On page 

2 D51 or D65 collimator clamp  4.3.1 and 

4.3.7 

24 and 

39 

3 – / programming and diagnostics 4.3.11 54 

4 PWR / 48 V power supply (in) for the scan head 4.3.6 37 

5 Monitoring port (450–950 nm) 4.3.10 53 

6 COMM / GSBus communication with the controller 4.3.5 34 

7 PMSI / process monitoring sensors interface 4.3.4 33 

8 HSSO / high speed serial output 4.3.3 30 

9 IN / cooling fluid to the scan head 4.3.2 28 

10 OUT / cooling fluid from the scan head 4.3.2 28 

11 – /cooling fluid to/from the thermopile/beam-dump box 4.3.2 28 

12 – /cooling fluid from/to the thermopile/beam-dump box 4.3.2 28 

13 Thermopile box with interface 

– OR – 

Beam dump box 

4.3.9 

 

– 

52 

 

– 

3.3 CONTROLS AND INDICATORS 

There are no controls or indicators on the scan head. 
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4 PREPARING FOR USE 

This chapter describes all procedures necessary to get the scan head ready for use. 

4.1 TRANSPORTING AND STORING 

Target audience and qualification 

Laymen, operators, and experts 

Requirements 

Table: Environmental 

Characteristic Specification 

Conditions Dry and clean indoor environment  

without electrically conductive contamination 

Operating temperature 15–40 °C (288–313 K) 

Storage temperature 0–60 °C (273–333 K) 

Humidity max. 80 % RH, non-condensing 

Procedure 

•  Transport and store the scan head in its sealed original packaging or an equivalent 

packaging. 
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4.2 UNPACKING AND VERIFYING THE SCOPE OF DELIVERY 

Target audience and qualification 

Experts  

Have ready 

□  Utility knife 

Procedure 

 If any shock indicator is present and triggered, then block the delivery, and inform the 

sender. 

 While carefully unpacking the scan head, keep in mind that you want to retain the 

packaging for future use. 

In case it will become necessary to return the scan head for some reason later, we 

recommend documenting the unpacking e.g., by taking photographs. 

 IMPORTANT 

Contamination can damage optics. 

• Leave any protective covers in place for as long as possible to keep the optics 

clean. 

 

 Check with the delivery note whether all parts are present, in an evidently immaculate 

mechanical state and whether the serial numbers correspond. If one of these is 

untrue, then block the delivery and inform the sender. 

 Retain the original packaging for future use. 

4.3 INSTALLING 

This section summarizes procedures necessary to mount the scan head in the laser unit and 

to connect all supply lines. 
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4.3.1 INCORPORATING THE SCAN HEAD INTO THE LASER UNIT 

Target audience and qualification 

Experts 

Have ready 

□ Machine bolts suitable for mounting the scan head in the laser unit; see Figure 3 on 

page 26. 

□ Suitable screwdriver, hexagon socket screw key set, Torx key set 

Requirements 

Table 1: Environmental 

Characteristic Specification 

Conditions Dry and clean indoor environment  

without electrically conductive contamination 

Operating temperature 15–40 °C (288–313 K) 

Storage temperature 0–60 °C (273–333 K) 

Humidity max. 80 % RH, non-condensing 

 

Table 2: Physical 

Characteristic Specification 

Enclosure IP rating IP65 

Max. dry weight 12 kg 

Dimensions with D51 collimator clamp  See Figure 3 on page 26 

Dimensions with D65 collimator clamp  See Figure 4 on page 27 
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Safety precautions 

□  Ensure fire extinguishing equipment is available and follow its instructions; see also 

section 2.6 on page 17. 

□  Switch off the laser unit, where the scan head is incorporated. Switch off the laser 

device, power supply, cooling and particularly disable moving parts. 

Procedure 

 IMPORTANT 

Contamination by burned protective covers can damage optics. 

• Remove protective covers at the last possible moment during the installation 

procedure. 

 

 WARNING 

Protective covers removed from unused monitoring ports can expose the user to laser 

radiation. 

• If you do not want to use a monitoring port, then leave the respective protective 

cover in place.  

The high band monitoring port is located at the top of the laser interface adapter. 

The low band monitoring port is located at the side with the electrical interfaces. 

 

•  To mount the scan head on its place in the laser unit, use the 3-point mounting as 

indicated in Figure 3 on page 26. 

Specifics of the interface 

Turn the page, please. 
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Figure 3: Dimensions in millimeter and mounting for D51 collimator clamp 
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Figure 4: Dimensions in millimeter and mounting for D65 collimator clamp 
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4.3.2 CONNECTING THE COOLING 

Target audience and qualification 

Experts 

Have ready 

□ Cooling connector at the scan head: 

mating connector: manufacturer Rectus/Parker; part number 21SBK006RVX 

□ Cooling connector at the laser interface adapter: 

mating connector: manufacturer Rectus/Parker; part number 20SBK006RVX 

□ Recommended hose:  

manufacturer Parker/Legris; part number 1025U06R08 

□ Utility knife to cut hoses in length 

□ Tissues to wipe of small amounts of coolant 

Requirements 

Table 3: Cooling 

Characteristic Specification 

Coolant (minimum)  Filtered (max. 100 µm particle size) DI-water 

Coolant (recommended) Filtered (max. 100 µm particle size) DI-water with additive 

COOLFLUX 42 

   – OR – 

Filtered (max. 100 µm particle size) distilled water mixed 

with Coolflow DTX (28 % concentration) 

   – OR – 

90 % of filtered (max. 100 µm particle size) distilled water 

with 10 % of OptiShield Plus or similar rust inhibitor 
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Characteristic Specification 

Inlet temperature 

(recommended) 1 

18–20 °C (291–293 K) 

Inlet pressure 3–4 bar (3000–4000 hPa) 

Volume flow 1.2–2.2 l/min 

Conductivity 35–45 µS 

Humidity max. 80 % RH, non-condensing 

Procedure 

 Note the flow direction; see Figure 5 on page 30. 

 Mount the mating connectors to the hose tips of the coolant supply and return lines. 

 Insert the mating connectors into the connectors at the scan head until they click into 

place. 

 IMPORTANT 

Leaking coolant can cause a short circuit and/or damage optics. 

 Check for leakage by opening the return line first and then carefully turning on the 

cooling water supply line and watching the connections. 

 If coolant is leaking immediately turn off the supply line, disconnect the leaking 

connection, wipe away any leaked coolant, correct the fault and redo the 

connection. 

– OR –  

If coolant is not leaking, then let it flow until the scan head is filled with water. 

 

 Turn off the coolant supply line first and then the return line. 

 

1 If operational temperatures outside the range given are required, please consult with your Novanta 

representative to determine whether this might be possible. 
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Later during commissioning, you will turn on the cooling again. 

Specifics of the interface 

Marked:  IN, OUT, or not marked, if the flow direction is irrelevant 

Connector: at the scan head manufacturer Rectus; part number  21KBAW10RVX 

 at the laser interface adapter: manufacturer Rectus; part number  

 20KBAM05RVX 

 

  

Figure 5: Position of the coolant supply and return connectors 

  Legend to Figure 5 

No. Labeling / function 

1 IN / cooling fluid to the scan head 

2 – /cooling fluid from/to the thermopile/beam-dump box 

3 – /cooling fluid to/from the thermopile/beam-dump box 

4 OUT / cooling fluid from the scan head 

4.3.3 CONNECTING THE HIGH-SPEED SERIAL OUTPUT  

The HSSO port emits a high-speed serial digital data stream comprising synchronized 

scanning and process data. 

This interface can be used for scan job monitoring and real-time process control. 

① ② ④ 

 

③ 
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The protocol used is based on the LVDS protocol, with a data rate of 48 MHz. Data available 

within this protocol includes: 

□ X, Y, Z commanded position coordinates 

□ X, Y, Z actual raw galvo position (uncorrected) 

□ Measured analog input voltages (0–10 V DC); channels A and B (up to 200 kHz 

acquisition rate) 

□ X, Y, Z user defined probe data 

Target audience and qualification 

Experts 

Have ready 

□  Interconnecting cable by PHOENIX CONTACT 

Length 1 m; male – male; part number 1407434   – OR – 

Length 2 m; male – male; part number 1407435  – OR – 

Length 5 m; male – male; part number 1407436  – OR – 

Length 5 m; male – unterminated; part number 1408743  – OR – 

Length 10 m; male – unterminated; part number 1408744 

Procedure 

 IMPORTANT 

“Hot” connection/disconnection of any power or data source is not advised and can result 

in damage to the product. 

• Connect the high-speed serial output according to the following information and 

only when the power is off. 

Specifics of the interface 

Marked:  HSSO 

Connector:  manufacturer PHOENIX CONTACT; part number 1437009 
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Table 4: Pin assignment of the HSSO connector 

 Pin Description Voltage level 

 

 

5 SPI_CLK+ LVDS 

8 SPI_CLK- LVDS 

1 SPI_SYNC+ LVDS 

7 SPI_SYNC- LVDS 

6 SPI_DATA+ LVDS 

4 SPI_DATA- LVDS 

2 Reserved – 

3 Reserved – 

    

Table 5: HSSO frame format 

Protocol ID Reserved 

Process ID 24-Bit binary representation of specific elements of job data – 

user defined and injected via SMC 

X command (ideal)  Scan job X-coordinate (pre correction table) 

X position (actual) Actual raw X-galvo position 

Y command (ideal) Scan job Y-coordinate (pre correction table) 

Y position (actual) Actual raw Y-galvo position 

ADC channel A  

(1st sample) 

20-Bit analog sensor reading – 1st time slice 

ADC channel A  

(2nd sample) 

20-Bit analog sensor reading – 2nd time slice 

X probe User defined Lightning™ II probe monitoring X axis 

1 2 

3 

4 

5 

6 

7 

8 
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Y probe User defined Lightning™ II probe monitoring Y axis 

Z command (ideal) Scan job Z-coordinate (pre correction table) 

ADC channel B 

(1st sample) 

20-Bit analog sensor reading – 1st time slice 

ADC channel B 

(2nd sample) 

20-Bit analog sensor reading – 2nd time slice 

Z position (actual) Actual raw Z-galvo position 

Z probe User defined Lightning™ II probe monitoring Z axis 

CRC 32 Error check 

4.3.4 CONNECTING PROCESS MONITORING SENSORS 

The scan head offers 2 analog input channels which can be connected to any sensor or signal 

conditioning module that supports a 0–10 V DC single ended output. The addition of process 

monitoring sensors allows the user to directly inject measurement data into the HSSO data 

stream (see section 4.3.3 on page 30), and make measurement data available via GSBus to 

ScanMaster Controller for use in monitoring and control schemes.  

Target audience and qualification 

Experts 

Have ready 

□  Interconnecting connector by PHOENIX CONTACT for cables of 4–8 mm in outer 

diameter 

□ Straight male connector; part number 1424662 – OR –  

Angled male connector; part number 1424663 – OR – 

Straight male data (500 kBit/s) connector; part no. 1424674 – OR – 

Angled male data (500 kBit/s) connector; part no. 1424675 
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Procedure 

 IMPORTANT 

“Hot” connection/disconnection of any power or data source is not advised and can result 

in damage to the product. 

• Connect the analog input according to the following information and only when the 

power is off. 

Specifics of the interface 

Marked:  PMSI (Process Monitoring Serial Interface) 

Connector:  manufacturer PHOENIX CONTACT; part number 1527870 

Table 6: Pin assignment of the PMSI connector 

 Pin Description Voltage level 

 

 

1 AIN 1+  Analog input 0–10 V DC; digitized by 

20-bit ADC; synchronized with position 

2 AIN 1- 0 V 

3 AIN 2+ Analog input 0–10 V DC; digitized by 

20-bit ADC; synchronized with position 

4 AIN 2-  0 V 

5 GND 0 V; may be used to shield the analog 

inputs but must not be connected to an 

external ground 

4.3.5 CONNECTING A GSBUS BASED CONTROLLER  

The GSBus is intended for connection via an adapter to a ScanMaster Controller.  

Target audience and qualification 

Experts 

2 1 

3 4 

5 
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Requirements 

□  The scan head has a 17-pin GSBus socket (female gender).  

Have ready 

□ ScanMaster Controller 

part number SMC-04-5-1-01-00-007  – OR – 

part number SMC-04-5-1-01-00-81F  – OR – 

part number SMC-04-5-1-01-01-007  – OR – 

part number SMC-04-5-1-01-01-81F 

For more information on these part numbers see section 8.1 on page 125. 

□  Interconnecting cable (twisted pair) by PHOENIX CONTACT 

Length 5 m; part number 1402421 – OR – 

Length 10 m; part number 1402422   

(Cable must not exceed 10 m in length.)  

Procedure 

 IMPORTANT 

“Hot” connection/disconnection of any power or data source is not advised and can result 

in damage to the product. 

1. Connect the controller according to the following information and only when the 

power is off. 
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 IMPORTANT 

The wiring and the grounding connections are critical to safe and sustained operation.  

2. Be sure to follow the recommended wiring and grounding scheme in section 4.3.7 

on page 39 ff. 

Specifics of the interface 

Marked:  COMM 

Connector:  manufacturer PHOENIX CONTACT; part number 1424197 

Table 7: Pin assignment of the GSBus connector 

 Pin Description 

 

 

1 CmdClk+ 

3 CmdClk- 

6 CmdSync+ 

4 CmdSync- 

5 CmdData+ 

8 CmdData- 

7 CmdClkEnb+ 

10 CmdClkEnb- 

9 StatClk+ 

2 StatClk- 

11 StatSync+ 

12 StatSync- 

13 StatData+ 

17 

1 2 

3 

4 

5 

6 7 

8 

9 

10 

11 12 

13 

14 15 

16 
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 Pin Description 

14 StatData- 

15 Comm+ 

16 Comm- 

17 Ack 

4.3.6 CONNECTING POWER 

Target audience and qualification 

Experts 

Requirements 

Table 8: Electrical supply 

Characteristic Specification 

Supply voltage +48 V DC; Tolerance ±2 V DC 

Input current min. 12.5 A 

Have ready 

□  Power supply; recommended: TDK RWS-600B or similar 

□ Interconnecting cable by PHOENIX CONTACT; 

Length 2 m; female – unterminated; part number: 1558360 – OR –   

Length 5 m; female – unterminated; part number: 1558373 

(Cable must not exceed 30 m in length. A length of 10 m or less is preferred.) 
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Procedure 

 IMPORTANT 

“Hot” connection/disconnection of any power or data source is not advised and can result 

in damage to the product. 

1. Connect the power lines according to the following information and only when the 

power is off. 

 

 IMPORTANT 

The wiring and the grounding connections are critical to safe and sustained operation.  

2. Be sure to follow the recommended wiring and grounding scheme in section 4.3.7 

on page 39 ff. 

Specifics of the interface 

Marked:  PWR 

Connector:  manufacturer PHOENIX CONTACT; M12, male 4-pin A-coded; part  

 number 1551875 

Table 9: Pin assignment of the PWR IN connector 

 Pin Description Voltage level Color code 

at cable 

 1 Chassis Protective earth 1)  Shield 

2 V+ 48 V  White 

3 V- 0 V 1)  Blue 

4 DGND Digital ground 1)  Yellow 

1) These lines must be tied together at the power supply. 

2 1 

3 4 
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4.3.7 RECOMMENDED WIRING AND GROUNDING SCHEME 

Technical advisories 

 IMPORTANT 

“Hot” connection/disconnection of any power or data source is not advised and can result 

in damage to the product. 

• Connect data and power lines only when the power is off. 

 

• All interconnection cables to Firefly3D must be shielded. 

• All interconnection cables to Firefly3D must have a length of no longer than 

10 meters. 

• Firefly3D and ScanMaster Controller products should be earthed to the same earthing 

point. 

• With the grounding scheme implemented as per Figure 6 on page 40 it is 

recommended that the SMC and Firefly3D are powered up at the same time. 

• The M12 connection on the GSB Adapter PCBa (D21520) should be grounded to the 

common protective earth. It is recommended that this be implemented using an M12 

ring crimp. The design intent was that the M12 connector would be bulkhead 

mounted to a surface such as a control panel that would itself be earthed. If this is not 

the case, then the mitigate described needs to be implemented. 
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48 Vdc power supply

Supply voltage: +48 V ±2 Vdc 
Current rating: min. 12.5 A
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NOTE
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the D21520 board to ensure it is 
sufficiently grounded. Should the 
M12 connector be mounted in a 
bulkhead, then the bulkhead should 
be grounded.
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-V

-V
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-V

-V
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Figure 6: Recommended wiring and grounding scheme 

4.3.8 CONNECTING A FIBER LASER 

Laser fibers are manufactured within given tolerances. There can be an offset in X- and Y-

direction and an angle in ϑ- and ϕ-direction between the fiber axis and the optical axis of the 

scan head. 
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To compensate for these tolerances, besides other purposes, there is the Laser Interface 

Adapter (LIA). Compensation is required with each mounting of the laser fiber to the LIA. 

Target audience and qualification 

Experts 

Requirements 

Table 10: Laser beam supply 

Characteristic Specification 

Laser standard industrial fiber laser in single- or 

multi-mode 

Fiber type standard industrial connector system 

(D51 or D65 collimator clamp) 

Wavelength 1050–1090 nm 

Laser power max. 1100 W 

Input clear aperture 20 mm 

Angular velocity max. 50 rad/s 

Integrated pointer laser wavelength 633 nm 

 

□  Clean and low-dust environment as you will dismount the LIA from the scan head and 

partially disassemble the LIA 

Have ready 

□  Laser safety glasses that are appropriate for the laser in use 

□  Laser fiber with collimator 

□  Alignment tool 

The LIA is mounted onto the alignment tool for adjustment, instead of mounting the 

LIA on the scan head. 
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Inside the tube is a thermopile. The thermopile can be moved between 2 positions. 

One position is near the LIA, the other is at the far end of the tube. These 2 locations 

provide a perspective that allows the user to align the laser beam through the LIA. 

A handheld power monitor is connected to the thermopile which shows the laser 

beam position and power measurement at the set measurement point.  

If the laser beam is centered to the thermopile at both ends of the tube, then the laser 

beam is adequately adjusted to the optical axis of the scan head. 

□  Torx key set to dismount and disassemble the LIA 

□  Cleaning utilities that are appropriate for cleaning precision optics 

□  Material to cover the laser beam entrance at the scan head,  

e.g., Polyamide tape 
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Safety precautions 

 WARNING 

Visible or invisible laser radiation can cause severe retinal and corneal burns, burns 

to the skin, and may pose a fire risk. 

• Switch off the laser emission. 

• Restrict access to the area where the alignment is done, to the persons who 

perform the adjustment and who wear appropriate laser safety glasses. 

• To avoid injury and reduce risk of fire, follow the control measures and safety 

guidelines provided by the laser’s manufacturer, and those established by your 

Laser Safety Officer (LSO), Radiation Safety Officer (RSO), or safety department 

of your business or institution. 

Procedure 

 IMPORTANT 

It is required that the procedure is done on site and the laser fiber must not be 

separated from the Laser Interface Adapter afterwards. 

 

 Ensure that the alignment tool is placed on a stable surface.  

 Clamp the base of the alignment tool to a firm base considering, especially when 

attaching the fiber and collimator later in this procedure. 

 Dismount the Laser Interface Adapter (LIA) from the scan head by loosening these 

screws; see Figure 7 on page 19. 
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Figure 7: Dismounting the Laser Interface Adapter (LIA) from the scan head 

 Cover the laser beam entrance of the scan head to prevent contamination. 

 Disassemble the LIA: 

a. Remove the 2 lower screws at the LIA’s thermopile; see Figure 8 on page 45, 

red arrows. 

b. The LIA block will come apart along its diagonal. Hold both parts securely 

while removing the transversal screws which are located at the bottom of the 

LIA; see Figure 8 on page 45, green arrows. 
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Figure 8: Disassembling the LIA 

The photograph below, Figure 9 on page 45, shows the separated LIA 

assembly. 

 

Figure 9: Disassembled LIA 

c. Put the upper part of the LIA to a clean and safe place. 

You will need it later when reassembling the LIA. 
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 Mount the lower part of the LIA on the alignment tool (the same way as you would 

mount it back on the scan head). 

The photograph below, Figure 10 on page 46, shows the LIA mounted on top of the 

alignment tool. Note that there is a knob on the side of the alignment tool, which can 

be gently pulled upon to allow the integrated detector to be moved between the 2 

levels marked Level 1 and Level 2 in the photograph below. 

Please note that the aluminum post shown in the photograph serves as a safety 

element in case of light emitted from the fold mirror within LIA directs light towards 

the power monitor/port.  

 

Figure 10: LIA mounted on top of the alignment tool 

Only once the LIA is securely attached to the alignment tool should coupling of the 

fiber collimator to the LIA be attempted. 

 Make sure that the optical surfaces at the laser fiber tip and the LIA are clean.  

 Carefully insert the collimator into the LIA up to its internal limit. 

 Clamp the collimator by tightening this screw; see Figure 11 on page 47. 
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Figure 11: Clamping the collimator to the LIA 

 Ensure all safety precautions are in place, and protective glasses are worn. 

 Set the laser to the lowest controllable radiant power. 

 WARNING 

Visible or invisible laser radiation can cause severe retinal and corneal burns, burns 

to the skin, and may pose a fire risk. 

• To avoid injury and reduce risk of fire, follow the control measures and safety 

guidelines provided by the laser’s manufacturer, and those established by your 

Laser Safety Officer (LSO), Radiation Safety Officer (RSO), or safety department 

of your business or institution. 

 

 Activate laser emission. 

 Monitor the laser beam position on the alignment tool’s thermopile via the handheld 

display, see Figure 12 on page 48, in the following. 
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Figure 12: Handheld display of the alignment tool’s thermopile 

Principle of alignment as described in step 14 

Using the OPHIR Starlight power meter use the mirror position adjustment screws 

within the LIA to move the beam such that the indicated power is as high as possible, 

and the beam location is centered as well as possible. 

The lower Level 2 position is likely to be more sensitive to adjustment than when the 

sensor is in the upper Level 1 position.  

It is very likely that there will be a compromise between power level and optimum 

position dependent on the angle of the incident beam and limitations of the 

mechanical assemblies. For instance, should there be an offset axis component in the 

beam’s propagation from the fiber, through the collimator, LIA and into the 

alignment tooling, alignment to an offset location may be necessary.  

The following example demonstrates this point. In this case the beam was offset, and 

the power level was matched to some offset position at both the Level 1 and Level 2 

measurement positions. 
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Example: 

 

Measurement at Level 1 

 

Measurement at Level 2 

The ideal state would be for the beam to pass through the exact center of both 

measurement levels. In this case, this alignment resulted in an angled beam 

approach angle as shown in the beam profile shown below.  

From the two levels of measurement taken above the angle of tilt can be determined 

using the following calculations. 

 Δx = 0.08 mm, 

 Δy = 0.05 mm, 

 Dm = 200 mm (Distance between Level1 and Level2); 

 tanα = Δx/Dm   ⇒   α = 0.023°, 

 tanβ = Δy/Dm   ⇒   β = 0.014° 

 

 Compensate the fabrication defects of the laser fiber with the LIA: 

a. To adjust for offset misalignment: 

i. Position the measurement sensor in Level 1; see Figure 10 on page 46. 

ii. Loosen the 4 fixing-screws; see Figure 13 on page 50, red arrows. 

iii. Use the adjusting screws; see Figure 13 on page 50, green arrows; to 

bring the laser beam to the thermopile center. 
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Figure 13: Adjusting for offset misalignment at the LIA 

The photograph below, Figure 14 on page 50, shows the LIA mounted 

on top of the alignment tool. Green arrows point to the XY adjusters. 

The top adjuster corrects for Y offset, while the side adjuster corrects 

for X offset. 

 

Figure 14: XY adjusters at the LIA 

b. To adjust for angular misalignment: 

i. Position the sensor in Level 2; see Figure 10 on page 46; as the angular 

deviation and the impact of the adjustment are more notable in this 

position. 

ii. Use the 4 adjustment screws; see Figure 15 on page 51; which are 

arranged in pairs around the folding mirror of the LIA to bring the laser 

beam to the center of the thermopile.  
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Each pair consists of a pressure screw (1), (3); see Figure 15 on page 51; 

and a draw screw (2), (4) and is responsible for adjusting one axis. The 

pair (1), (2) on the side of the mirror is responsible for adjusting the X-

axis. The pair (3), (4) above the mirror is responsible for adjusting the 

Y-axis. The pressure screw raises the mirror holder, and the draw screw 

lowers it. As the mirror holder is clamped between the screws, both 

screws must be equally tightened or loosened during adjustment in 

order to securely lock the mirror holder in position. 

 

Figure 15: Adjusting for angular misalignment at the LIA 

Adjustment along the X-axis: 

• Loosening the pressure screw (1) and simultaneously tightening 

the draw screw (2) increases the X-coordinate of the laser 

beam. 

• Tightening the pressure screw (1) and simultaneously loosening 

the draw screw (2) reduces the X-coordinate of the laser beam. 

① 

② 

③ ④ 
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Adjustment along the Y-axis: 

• Tightening the pressure screw (3) and simultaneously loosening 

the draw screw (4) increases the Y-coordinate of the laser 

beam. 

• Loosening the pressure screw (3) and simultaneously 

tightening the draw screw (4) reduces the Y-coordinate of the 

laser beam. 

As soon as the laser beam is centered to the thermopile at both measurement 

positions, the laser beam is adequately aligned to the optical axis of the scan 

head. 

c. Repeat the steps above until alignment is attended.  

 Tighten the 4 fixing-screws, highlighted by red arrows in Figure 13 on page 50. 

 Switch off the laser emission. 

 Dismount the LIA from the alignment tool. 

 Reassemble the LIA and check the cleanliness of the optical surfaces. 

 Remount the LIA to the scan head. 

4.3.9 CONNECTING THE THERMOPILE (OPTIONAL) 

Target audience and qualification 

Experts 

Have ready 

□ Mating product: manufacturer binder-connector  

On website, set the search filter for: subminiature connector, number of contacts 2, 

lock M9, degree of protection IP67, version connector male angled or straight. 
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Procedure 

 IMPORTANT 

“Hot” connection/disconnection of any power or data source is not advised and can result 

in damage to the product. 

• Connect the thermopile only when the power is off and according to the following 

information. 

Internally a Thermopile gRay C50-MC-LA is installed. (Correct at the time of 

publication. Novanta reserves the right to change without notice.) 

Specifics of the interface 

Marked:  – 

Connector:  manufacturer binder-connector; part number 0904040002 

Table 11: Pin assignment of the thermopile connector 

 Pin Description 
 

 1 Negative 

2 Positive 

4.3.10 CONNECTING TO OPTICAL SENSORS AND VISION CAMERAS 

Target audience and qualification 

Experts 

Procedure 

•  Connect the monitoring system according to the following information. 

2 

1 
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Specifics of the interface 

 

Figure 16: Position of monitoring ports 

Legend to Figure 16 

No. Labeling / function Dimensions see On page 

1 Monitoring port (1200–2000 nm) Figure 3 and 

Figure 4 

26 

27 
2 Monitoring port (450–950 nm) 

4.3.11 DIAGNOSTICS CONNECTOR 

The USB interface is only intended for software/firmware updates and diagnostics. It allows 

access to servo driver function and status reporting. Details are relevant for service personnel 

only and not provided here. 

① 

② 
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Target audience and qualification 

Trained service and Novanta personnel  

Have ready 

□  Interconnecting USB cable terminated by a USB type B plug at one side  

Procedure 

•  Do not connect. 

Specifics of the interface 

Marked:  – 

Connector:  USB type B socket 

 

Figure 17: USB interface 

4.3.12 CONNECTING A LASER TO SCANMASTER CONTROLLER 

It is assumed that the Firefly3D scan head will be used with the ScanMaster Controller in a 

system setup similar to the example shown in Figure 18 on page 55.  

 

 

 

 

 

 

 

 

Figure 18: Example for a system setup with an IPG YLR fiber laser 

Firefly3D  

Scan Head Ethernet GSBus 

48 V DC 24 to 48 V DC 

IPG YLR  

Fiber Laser 

Controlling 

Computer 

ScanMaster 

Controller 
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Target audience and qualification 

Experts  

Procedure 

 IMPORTANT 

The connections given in Table 12 on page 56 have been tested with an IPG YLR laser. At 

the time of writing this information is correct, however the user is urged to check these 

connections are suitable for the laser in use, even when connecting to an IPG YLR laser as 

changes to this product may have been introduced by the manufacturer. Other laser types 

may require different connections or methods of operation. Novanta recommends that the 

user check the interface requirements of the laser used in all cases. Novanta does not 

accept any liability for damage caused through incorrect connections, the information 

provided here is for guidance purposes only. 

1. Before connecting the laser to the ScanMaster Controller consult with the laser 

manufacturers documentation. 

 

 IMPORTANT 

“Hot” connection/disconnection of any power or data source is not advised and can result 

in damage to the product. 

2. Connect the laser only when the power is off and according to the following 

information. 

Table 12: Example for the lines between controller and laser 

ScanMaster Controller High Power Laser Adapter 

(SMC-LSR-04) 

 IPG YLR Laser 

Description Connector Pin number  Pin number 

Laser gate J2 3  18 

Modulation J2 4   15 
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ScanMaster Controller High Power Laser Adapter 

(SMC-LSR-04) 

 IPG YLR Laser 

Description Connector Pin number  Pin number 

GND J2 6  14, 16, 20 

Laser analog J2 7  12 

24 V J3 1  –   

GND J3 2  – 

4.3.13 INSTALLING THE SOFTWARE 

It is assumed that the Firefly3D scan head will be used with ScanMaster Controller. Use the 

following software to fully utilize the capability and performance of the system. The software 

listed within this section represents a core set of applications and APIs that will allow the user 

to use Firefly3D in several different ways. Depending on the end user installation it is likely 

that not all these software solutions will be required. 

Target audience and qualification 

Experts  

Procedure 

1. Download all (recommended) software listed in Table 13 on page 58. 

The software can be obtained from your local Novanta representative or from: 

https://novantaphotonics.com/secure-download-scanmaster/  

https://novantaphotonics.com/secure-download-scanmaster/
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Table 13: Software list 

Software application Minimum 

version 

required 

Purpose User level 

ScanMaster SDK, incl. 

 Device Config. Editor,

 Broadcast Monitor,

 Firmware Loader,

 Remote Admin. 

3.2.5 Low level communication 

to the controller, 

configuration, and legacy 

API functionality 

Software 

engineer / 

Process 

engineer 

ScanMaster API 3.2.5 .net Framework compliant 

API for all new designs 

Software 

engineer 

ScanMaster Designer 3.2.5.x User friendly desktop 

application for developing 

scan projects  

User / All 

Calibration Wizard 2.1.6 Beta 3 Calibration software to set 

up the scanners field 

correction  

Process 

engineer 

TuneMaster 2 Support 

Module 

4.5.3.34646 Diagnostics, monitoring, 

and configuration software 

of the underlying scanning 

system  

Software 

engineer / 

Process 

engineer 
TuneMaster 2 Support 

Module (Legacy mode) 

4.5.3.34646 

 

2. Install the software applications on the controlling computer that is connected via 

Ethernet to the ScanMaster Controller. 

You will need administrator rights on the controlling computer.  

As a general guide it is usually good practice to install ScanMaster SDK first followed 

by ScanMaster API and lastly ScanMaster Designer. Calibration Wizard and TuneMaster 

2 Support Module can be installed independently. 
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There is additional detailed documentation contained within each software 

application, accessible once installed, which the reader is urged to study. 

4.4 COMMISSIONING 

This section describes how to commission the scan head, i.e., what must be done when 

switching it on for the first time. 

 IMPORTANT 

Uncontrolled laser emission can lead to property damage. 

• The integrator must implement supervision of the scan head state and stop laser 

emission in fault condition.  

If necessary, the integrator must take additional appropriate protective measures to 

prevent damage by uncontrolled laser emission. 

 

4.4.1 SWITCHING ON FOR THE FIRST TIME 

Target audience and qualification 

Experts 

Requirements 

□ The installation has been completed in the described way; see section 4.3 on page 23 

ff. Please check the installation once again to ensure this. 

Procedure 

 Check, if the settings for cooling are correct; see also Table 3 on page 28. 
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 IMPORTANT 

Pressure surge can damage the scan head’s cooling loop. Secondary damage to 

electronics and optics by cooling water is possible. 

 First open the coolant return line and then carefully open the coolant supply line. 

 

 Switch on the power. 

 Commission Firefly3D via the controlling computer as described in the following 

sections. 

Find further reading about commissioning and controlling the scan head and the laser 

in the respective documentation. 

4.4.2 SETTING THE DEVICE CONFIGURATION 

Target audience and qualification 

Experts 

Requirements 

□ The system has been switched on as described in section 4.4.1 on page 59. 

Procedure 

1. On the controlling computer, start the Device Configuration Editor software 

application. 

The SMC Device Configuration window opens.  

2. In the navigation on the left-hand side, expand Controller Configuration and click 

ControlConfig.xml.  
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3. Select the Controller Configuration tab and within the Galvo Axis Config groups Head 

1 and Head 2, make sure the settings are as shown in Figure 19 on page 61. 

 

Figure 19: Editing the SMC Device Configuration 

4. Click OK. 

This applies changed values and closes the Device Configuration Editor window.  

4.4.3 CALIBRATING THE SCAN FIELD 

Target audience and qualification 

Experts 

Requirements 

□ The device has been configured as described in section 4.4.2 on page 60. 

Procedure 

1. On the controlling computer, start the Calibration Wizard software application. 

The Calibration Wizard window opens. 



4 Preparing for use 4.4 Commissioning 

Firefly3D Scan Head, User Manual, 1040–0001 Rev. 03 62 

 

Figure 20: Calibration Wizard 

2. Referring to Figure 20 on page 62, configure the software in the following way: 

(1) In the Controller Units list, double-click the controller displayed to establish a 

connection to the controller.  

A successful connection is indicated by the Connected light illuminated 

green. 

(2) Activate the Three axis system box to identify the system as  

a 3-axis system. 

(3) Click Set system configuration. 

(4) In the Head type list, select … (FireFly). 

① 

② 

③ 

⑥ 

⑤ 

④ 
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 IMPORTANT 

This instruction is based on the use of an IPG YLR laser. At the time of writing 

this information is correct, however the user is urged to check these 

connections are suitable for the laser in use, even when connecting to an IPG 

YLR laser as changes to this product may have been introduced by the 

manufacturer. Other laser types may require different connections or 

methods of operation. Novanta recommends that the user check the 

interface requirements of the laser used in all cases. Novanta does not accept 

any liability for damage caused through incorrect connections, the 

information provided here is for guidance purposes only. 

• Before connecting the laser to the ScanMaster Controller consult with 

the laser manufacturers documentation. 

 

(5) In the Laser type list, select IPG YLR or the laser type that is planned to be 

used. 

(6) In the case of using an IPG YLR laser set the Duty-cycle to 0 %. 

3. If a test firing of the laser is needed to confirm the alignment of the laser beam, then 

click Align laser. 

If it is needed to intensify or clarify the marking, then click Set focus/marking params. 

4. To start the process of setting up a field correction, click Create correction table. 

The Correction Table Editor window with default settings opens; see Figure 21 on page 

64.  
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Figure 21: Correction Table Editor 

During the following process the messages shown below may pop up. Please take the 

action advised in the respective caption. 

 

Click Continue. 

 

Click OK. 

 

5. Enter the Target field size – OR – Working distance to define the model parameters 

that will be used to develop the correction table. 

The Working distance is defined as the distance between the target and the bottom 

side of the scan head. (This excludes the protruding fastening screw threads.) 
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As an example, we will configure the Working distance to 594 mm as shown in Figure 

22 on page 65, point (2). This will allow us to attain a maximum theoretical Target field 

size of 588 mm, as shown in the figure, point (1), below. 

 

Figure 22: Example: Setting the Working distance 

Next the baseline correction needs to be set. 

6. In the menu, click Edit → Synthesize baseline correction. 

The program will calculate the field corrections and generate a field view like that 

shown in Figure 23 on page 66 on the right-hand side. 

① 

② 
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Figure 23: Synthesizing the baseline correction 

7. Close the correction table editor, upon which several confirmation message boxes will 

be presented to the user.  

8. Answer each question by clicking the respective button. 

The table will be activated and loaded into the controller for the change to take 

effect. 

The Calibration Wizard window is open now; see Figure 24 on page 67. 
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Figure 24: Scanning the center focus pattern 

Next a center focus pattern needs to be scanned successfully. 

9. Referring to Figure 24 on page 67, this is achieved by taking the following steps:  

(1) Click Set center-focus offset. 

(2) After reviewing the pattern parameters, click Run. 

The laser will fire, and the scanner will scan the pattern depicted in the 

window (3). 

If the focus distance is set correctly then the laser should mark the marking paper 

or marking plate with a pattern that resembles the photograph below.  

① 

② ③ 
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However, this may not always be the case, and the user may have to adjust the 

Z Offset until such time that the laser visibility marks the target material. During 

this process, laser power and/or scanning speed may need to be optimized on 

several occasions. 

If required, the focus can be adjusted by clicking Adjust focal plane and then 

entering a Z Offset value into the Correction Table as shown in Figure 25 on page 

69.  
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Figure 25: Adjusting the Z Offset 

a. Z Offset correction is the field that is marked by a red box in Figure 25 on 

page 69. Enter the offset value in millimeters there.  

b. Close the correction table editor, upon which several confirmation message 

boxes will be presented to the user.  

Answer each question by clicking the respective button. 

The table will be activated and loaded into the controller for the change to 

take effect.  

It is expected that the focus will be more difficult to find as the field size 

increases. Consequently, the number of iterations may increase. It is 

recommended that steps of 25 mm be used when searching for the focus. 

Once the center focus has been obtained it is expected that the scanned pattern 

should look like that shown in the photograph below. Although not extremely 

① 

② 



4 Preparing for use 4.4 Commissioning 

Firefly3D Scan Head, User Manual, 1040–0001 Rev. 03 70 

easy to see the middle row carries the highest intensity, with decreasing levels of 

intensity as the focus passes above and below the focal point. 

 

Next the focal plane correction needs to be performed. 

10. This is achieved by scanning a selection of patterns across the entire scan field set 

within the field correction model. Figure 26 on page 71 describes the set up. 
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Figure 26: Adjusting the focal plane 

(1) Click Adjust focal plane. 

(2) In the Focal plane parameters group, define the focal plane parameters to attain 

the most appropriate resolution and quality for the system. 

(3) Click Run to scan the pattern shown in the window (4). 

An example of a scanned pattern is shown in the photograph below.  

① 

③ ④ ② 
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11. Corrections can be applied to regions that are not in focus: 

a. Click Edit table. 

The Correction Table Editor window opens. 

b. In the main menu, click Measure → Collect focal plane data.  

The Collect focus array data window opens. 

 

Figure 27: Collecting the focus array data 

c. Enter the correction values. 

d. Click OK. 
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Typically, a few iterations are expected, given a good center focus calibration, 

to attain a good focal plan calibration, an example of which is shown in the 

photograph below. 

 

The last stage in the calibration process is to configure a Correction grid, from which 

measurements can be taken. These measurements are used to correct pin cushion, 

barrel effects and final field flattening compensation. The example below is based on 

a manual measurement and data entry approach. For high precision applications it is 

assumed that a CMM or camera-based system will be used to measure the grid 

accuracy. Data from this measurement can be imported back into Calibration Wizard 

using the procedure described at the end of this section. 

12. Referring to Figure 28 on page 74, a correction grid can be created by taking the 

following steps. 
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Figure 28: Adjusting the correction table 

(1) Click Adjust correction table. 

(2) Set the marking parameters, in this case for a calibrated grid Size of 

200 × 200 mm. 

(3) Click Run to scan the pattern as shown in (4). 

As shown by point (2) in Figure 28 on page 74, there is a wide range of calibration 

grids that can be defined by adjusting these values. With the correction grid 

scanned it needs to be measured and correction often correction factors applied. 

This is often an iterative task. In this example the measurement acquisition 

method is manually based. In precision applications this method is of limited use, 

and more precise measurement techniques should be used. A description at how 

to import measurement data into the Calibration Wizard can be found in section 

4.4.4 on page 76. 

(5) Click Edit table. 

③ ④ ② 

① 

⑤ 
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The Correction Table Editor window opens. 

13. In the main menu, click Measure → Collect Box/Cross grid data.  

The Collect Box/Cross grid data window opens, where measured values can be entered 

which are used by the software to correct the field; see Figure 29 on page 75. 

  

Figure 29: Collecting Box/Cross grid data 

14. Enter all corrections. 

15. Click OK. 

There is an option to save the measurement correction data should this be required.  

Click the Edit Correction Table window and save the file to the controller when asked.  

When the software returns to the screen shown in Figure 28 on page 74 and if the 

field requires further corrections then re-scan the correction grid and repeat the 

process of scan→ measure → edit correction values. If the field accuracy is acceptable 

the process of field correction is complete. 
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4.4.4 IMPORTING MEASUREMENT DATA INTO THE CALIBRATION WIZARD 

If the application requires a higher degree of precision, manual measurement techniques are 

limited. The correction grid will need to be measured using other techniques such as an 

optical CMM. The data that is reported from these measurement equipment’s can be 

imported back into Calibration wizard. The process to import this correction data is briefly 

described below. 

Target audience and qualification 

Experts 

Procedure 

 Referring briefly back to Figure 28 on page 74, click Edit table. 

The Correction Table Editor window opens; see Figure 30 on page 77. 
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Figure 30: Importing measurement data into the Calibration Wizard 

 From the main menu, click File → Import → Measurement data from. 

This offers the possibility to import a text file in one of two defined formats and 

allows the user to input precision measurement data. All other steps to correct the 

field remain the same as described in section 4.4.3 on page 61. 

4.5 DIAGNOSTICS AND TOOLS TO OPTIMIZE THE SCANNING 

PROCESS 

At the heart of Firefly3D is an advanced digital scanning system, Lightning™ II. TuneMaster 

Support Module software can be used to connect to Firefly3D to access its features. There are 
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2 methods of connection, via a ScanMaster Controller card connected to Firefly3D or a less 

functional connection path via Firefly3D’s USB connector. This section will explore 

functionality available via ScanMaster Controller card only.  

4.5.1 USING THE SCANMASTER CONTROLLER AS A HOST 

TuneMaster™ II Support Module is a standalone windows application that allows users to 

perform the following tasks: 

• Ascertain current status of the beam steering system 

• Upgrade software, firmware, and configuration 

• Monitor specific parameters relating to the scan head operation including position, 

velocity, operating temperature, acceleration, and in addition process monitoring 

sensors channels can be configured and monitored 

• Frequency response and friction plots can be generated to provide Novanta 

personnel with parametric information that may be useful in the event of an issue 

• Plots of actual scanned versus planned trajectories can be generated for scan pattern 

development, optimization and debugging purposes  

Target audience and qualification 

Experts 

Procedure 

 Within TuneMaster™ II Support Module, check the version installed on your computer 

by clicking Help → About as shown in Figure 31 on page 79. 
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Figure 31: Opening the TuneMaster™ II Support Module About box 

A window opens, see Figure 32 on page 79, which displays the version number, in this 

case 4.5.4.34646. The version must be at least version 4.5.4.34646. 

 

Figure 32: TuneMaster™ II Support Module About box 

 Close this window by clicking OK. 

 Close the TuneMaster™ II Support Module application. 
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You can configure TuneMaster™ II Support Module application to use ScanMaster 

Controller as a host by adding the text smc after the command line call to the 

program’s executable. How to achieve this is explained below.  

 Find the installed instance of the TuneMaster™ II Support Module executable file 

TM2_Support.exe.  

This can usually be found by navigating to the path given below in the file system. 

C:\Program Files (x86)\Cambridge Technology\TM2 Support\TM2_Support.exe 

 Right click file TM2_Support.exe and select Create shortcut.   

 If not done automatically ensure the shortcut is placed on the desktop. 

There should now be an icon on the desktop that looks similar to that shown in Figure 

33 on page 80. 

 

Figure 33: TM2_Support SMC icon 

 Right click this shortcut and select Properties.  

The TM2_Support SMC Properties window opens.  

 In the Target field add the text smc at the end of the string as shown in Figure 34 on 

page 81. 
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Figure 34: Editing the TM2_Support SMC shortcut properties 

 Click Apply. 

 Click OK. 

 To start TuneMaster™ II Support Module, double click the desktop shortcut.  

The first time the program is executed a windows security alert, similar to that shown 

in Figure 35 on page 82, may appear. 
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Figure 35: Allowing access through the Windows Defender Firewall 

 Ensure that Private network and Public network are checked to ensure correct 

function. 

 Click Allow access. 

The program starts, and after 10 to 20 seconds the TuneMaster II – Support Module 

window opens; see Figure 36 on page 82. 

 

Figure 36: TuneMaster II Support Module main screen 

The next section describes in brief how some performance plots can be obtained.  
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Procedure to obtain a Bode Plot or Friction Plot 

 From TuneMaster™ II Support Module, in the menu, click Tools → Retrieve TM2 file 

from Gsb Location 0; see Figure 37 on page 83. 

 

Figure 37: Retrieving TM2 file from Gab Location 0 

 Save the TM2-file to a location on your computer. 

 In the menu, click Tools → Bode Plot or Tools → Friction Plot, depending on the type 

of plot desired; see Figure 38 and Figure 39 on page 84. 

The software will instruct the scan head to commence a series of movements, 

acquiring data as it does, to generate plots similar to those shown below.  

While the system is generating this waveform, do not make additional selections or 

interrupt operation. 
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Figure 38: Example: Bode Plot Figure 39: Example: Friction Plot 

 

 To stop taking the active measurement, close the larger window, also known as the 

virtual scope.  

This will stop the mirror motion and reconfigure the system back to a normal state 

ready for operation.  

4.5.2 READING CONFIGURATION INFORMATION 

Additional information can be obtained which can be helpful in determining the 

configuration of the scanning system. This information can be helpful when communicating 

with Novanta.  

Target audience and qualification 

Experts 

Procedure 

 Using TuneMaster™ II Support Module, from the main menu, select Tools → Get 

available devices.  

The Message Window open; see Figure 40 on page 85. It reports the presence and 

configuration of each of the active elements within a Firefly3D scan head. 
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Figure 40: Example: Listing available devices 

Detailed firmware information can be displayed as follows. 

 From the main menu, select Tools → Show firmware versions. 

An example of the typical output expected from this command is shown in Figure 41 

on page 85. 

 

Figure 41: Example: Listing firmware versions 

4.5.3 CONFIGURING TUNEMASTER II – SUPPORT MODULE TO OBSERVE 

SCANNING TRAJECTORIES 

Firefly3D incorporates a Lightning™ II pure digital scanning system. This allows the user to 

make use of some advanced trajectory planning and monitoring tools. In this section the 

reader is walked through a series of steps required to configure TuneMaster™ II Support 

Module to observe the planned and actual scan trajectories in real time. 
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Target audience and qualification 

Experts 

Procedure 

 Using TuneMaster™ II Support Module, from the main menu, select Tools → Retrieve 

TM2 file from Gsb Location 0; see figure below.  

 

TuneMaster II Support Module main screen 

 Save the TM2-file to a location on your computer. 

 From the toolbar, click the probe set up icon . 

The Probe Setup window opens; see Figure 42 on page 87. 
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Figure 42: Setting up the probes 

 Use the settings shown in Table 14 on page 87 and Table 15 on page 88 to setup the 

Probes so that it looks similar to that shown in Figure 42 on page 87.  

Note for the purposes of this exercise the ZAxis and Adapter Board Probes need not 

be configured. 

Table 14: Probe settings 1 (2) 

Axis Probe name Scale Offset Wrap 

XAxis 30mm CMD_RAW 0.195 0.000 No 

 MOTOR_LOAD 0.195 0.000 No 

YAxis 30mm CMD_RAW 0.195 0.000 No 

 MOTOR_LOAD 0.195 0.000 No 
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Table 15: Probe settings 2 (2) 

Triggering mode Soft trigger, trigger immediately 

Samples 65530 

Trigger control  Repeat 

Delay 1000 ms 

  

 Adhere to the following procedure when setting up each probe; see also figures 

below. 

Test Point Settings: 

a. In the TP list, select the probe you want to assign. 

b. Edit the Scale such that it is appropriate for the probe.  

For example, most motion related measurements use a Scale of 0.195, whereas 

temperatures will require a higher Scale of say 100 to represent 100 °C. 

c. Click Set Probe to commit the values.  

Trigger Settings: 

a. For general monitoring, set the Triggering mode to Soft trigger, trigger 

immediately. 

b. Increase the Samples count to a suitable number of samples for the 

measurement being taken.  

The maximum count is 65530. 
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c. Click Set Trigger to commit the values. 

 

Figure 43: Setting the Scale and Triggering 

 From the tool bar, open the Virtual scope by clicking button  ; see figure below. 
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TuneMaster II Support Module main screen 

The virtual scope brings with it many of the common features of a real oscilloscope. 

Within the virtual oscilloscope we use the Math 1 and Math 2 options as shown in 

Figure 44 on page 90 to configure the scope to display trajectories.  

 Click on the Scale all button  . 

The virtual scope displays a screen similar to that shown below.  

 

Figure 44: Virtual oscilloscope 
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 Start the scanning job you wish to analyze.  

For the purposes at this example we use ScanMaster Designer, see Figure 45 on page 

91, to scan a simple square as shown in the image below. In this example we iterate 

the square 100 times to give us time to observe and capture the trace within the 

virtual oscilloscope; see Figure 46 on page 91. 

 

Figure 45: ScanMaster Designer 

 

Figure 46: Example: Virtual Oscilloscope 
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By using the mouse wheel or creating a bounding box over the region of interest we 

can zoom in and out of the plot.  

Referring to the example in Figure 47 on page 92 we can see how the actual scan 

path deviates from the ideal trajectory in the corner.  

 

Figure 47: Example: Actual scan path deviates from ideal trajectories 

This concludes our short introduction to functionality offered by TuneMaster™ II – Support 

Module. Should you require more information please contact your local Novanta 

representative or the download section of our website. 

4.6 TUTORIAL: TUNE MODE SWITCHING 

The purpose of this tutorial is to guide the reader through the following actions. 

• Confirming the current tune status 

• Exchanging tunes between Traditional and Scan Pack tune modes 

• Confirming tune behavior 

For the purpose of this guide, it is assumed that Firefly3D is in its default Traditional mode of 

operation. This is the default state when the product is shipped from the factory. 
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Please note that within this guide Traditional and Vector will be used interchangeably and 

refer to the same tune. 

 

4.6.1 REQUIREMENTS 

Switching between tunes requires that the user has the appropriate tune file. In the case of 

Firefly3D at the time of writing the 2 tunes and their associated file names are listed below. 

Tune type File name 

Vector CF-000944_L2Q30X3-xxxA-xx-Q489.TM2 

Scan Pack CF-000953_L2Q30X3-xxxA-xx-Q494.TM2 

 

These files can be obtained from your Novanta representative on request. Firefly3D is 

shipped by default in Vector tune mode. The tuning is defined by the tune loaded and the 

control mode set in the ScanMaster Controller (SMC) configuration. This control mode is 

called Command Generation Mode (CGM).  

4.6.2 CHECK THE TUNE MODE 

Target audience and qualification 

Operators and experts 

Procedure 

1. Run the Device Configuration Editor to check the operation mode.  

2. In the left-hand pane, click ControlConfig.xml. 

As can be seen in the figure below, the Command Generation Mode is set to 

Traditional or Vector control mode. 
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It is wise to also have an awareness of the servo parameter settings initially.  

3. In the left-hand pane, click ServoParams.xml. 

Observe the parameters as shown in the figure below.  

 

 

4. Next, we are going to explore the Traditional / Vector tune mode behavior.  

4.6.3 EXPLORING TRADITIONAL / VECTOR TUNE MODE BEHAVIOR 

To confirm the operation mode practically, the following procedure in ScanMaster Designer 

can be followed. 

Target audience and qualification 

Operators and experts 
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Procedure 

1. Disconnect any other software that may be communicating with ScanMaster 

Controller (SMC), as this may interfere/prevent progression or successful completion 

of the procedure.  

2. Start ScanMaster Designer, and when available double-click on the SMC to connect as 

shown in the figure below. 

 

 

3. Navigate to File → Preferences → Marking Area. 

4. Click on Get From Device.  

This will load the base dimensions of the calibrated field, in this case 696 mm, as 

shown in the figure below. 
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5. Click on OK to close the window and return to the main screen.  

6. Click on New to start a new project. 

7. Draw a small square in the middle of the canvas. 

8. Set up the Mark Speed to 1000 mm/s as shown below in the figure below. 
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9. Open TuneMaster Support Module, and configure the Probes as shown in the figure 

and table below.  

 

 

Channel Probe name (TP) Scale Offset 

GsbLoc 0 CMD_RAW 0.25 0.0 

GsbLoc 0 MOTOR_LOAD 0.25 0.0 

GsbLoc 1 CMD_RAW 0.25 0.0 

GsbLoc 1 MOTOR_LOAD 0.25 0.0 

GsbLoc 10 Disabled n/a n/a 
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Channel Probe name (TP) Scale Offset 

GsbLoc 17 Disabled n/a n/a 

 

10. Set the Triggering as shown in the figure below. 

 

 

11. Click on Set Trigger ensuring that all the LED’s are lit as shown in the figure below.  

Should this not happen within a few seconds, set the Triggering mode to Triggering 

Off, click Set Trigger, revert the Triggering mode to Soft trigger, trigger immediately 

and click on Set Trigger again. 

 

 

12. With the probe channels set up and active, the Virtual Oscilloscope now needs to be 

configured, as shown in the figure below. 
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13. Run the scan job from ScanMaster Designer, allowing enough repetitions to give 

enough time to capture the trace in the Virtual Oscilloscope as shown in the figure 

below. 

 

 

14. Zoom into the upper left corner and note the effect as shown in the figure below. 
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15. In ScanMaster Designer stop the scan job and increase the Mark Speed of the shape to 

a higher speed such as 5000 mm/s.  

Note how the error increases as the system needs to cut the corner of the geometry 

to maintain as much speed as possible as shown in the figure below. 

 

 

This is typical behavior of a Vector / Traditional configured system.  

16. Return to TuneMaster II - Support Module, main window.  

17. Close all the windows except for the main one shown in the figure below (in next 

subsection). 

Next, we are going to switch the tune to ScanPack mode. 
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4.6.4 SWITCHING TO SCANPACK TUNE MODE 

Target audience and qualification 

Operators and experts 

Procedure 

It is often preferable to leave a few seconds between each step in the process 

described below. 

1. In the TuneMaster II - Support Module, select Gsb Location 0; (1) in the figure below.  

 

 

2. Select the folder icon; (2) in the figure above. 

② ③ ④ 

⑤ 

① 
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3. Select the ScanPack tune file, which in this case is as listed below  

CF-000953_L2Q30X3-xxxA-xx-Q494.TM2.  

Tune type File name 

Traditional / Vector CF-000944_L2Q30X3-xxxA-xx-Q489.TM2 

ScanPack CF-000953_L2Q30X3-xxxA-xx-Q494.TM2 

 

4. Once the tune is loaded into TuneMaster II – Support Module, select Reset from the 

drop-down menu; (3) in the figure above. 

5. Click on Flash; (4) in the figure above.  

It is often preferable to leave a few seconds between each step in the process 

described above.  

To fix the tune in place the servo needs to be reset:  

6. Click on the LED associated with the axis being worked on indicated by (5) in the 

figure above.  

7. Repeat the process described above for Gsb Locations 1 and 10.  

8. Make sure you have disconnected from ScanMaster Designer.  

9. Use the Device Configuration Editor to set the Command Generation Mode to 

ScanPack as shown in the figure below. 

 

 

10. Power cycle both, the SMC and Firefly3D. 

11. Open Device Configuration Editor again and check the Command Generation Mode 

and Servo Parameters.  
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They should be similar to that shown in the next 2 figures. 

The change in Max Velocity is indicative of a correctly configured ScanPack system. 

 

 

 

4.6.5 EXPLORING SCANPACK TUNE MODE BEHAVIOR 

To confirm the operation mode practically, the following procedure in ScanMaster Designer 

can be followed. 

Target audience and qualification 

Operators and experts 
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Procedure 

1. Disconnect any other software that may be communicating with ScanMaster 

Controller (SMC), as this may interfere / prevent progression or successful completion 

of the process defined below.  

2. Start ScanMaster Designer, and when available double-click on the SMC to connect as 

shown in the figure below. 

 

 

3. Navigate to File → Preferences → Marking Area. 

4. Click on Get From Device.  

This will load the base dimensions of the calibrated field, in this case 696 mm, as 

shown in the figure below. 
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5. Click on OK to close the window and return to the main screen.  

6. Click on New to start a new project. 

7. Draw a small square in the middle of the canvas. 

8. Set up the Mark Speed to 1000 mm/s as shown in the figure below. 
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9. Open TuneMaster Support Module, and configure the Probes as shown in the figure 

and table below. 

 

  

Channel Probe name (TP) Scale Offset 

GsbLoc 0 CMD_RAW 0.25 0.0 

GsbLoc 0 MOTOR_LOAD 0.25 0.0 

GsbLoc 1 CMD_RAW 0.25 0.0 
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Channel Probe name (TP) Scale Offset 

GsbLoc 1 MOTOR_LOAD 0.25 0.0 

GsbLoc 10 Disabled n/a n/a 

GsbLoc 17 Disabled n/a n/a 

 

10. Set the Triggering as shown in the figure below. 

 

 

11. Click on Set Trigger ensuring that all the LED’s are lit as shown in the figure below. 

Should this not happen within a few seconds, set the Triggering mode to Triggering 

Off, click Set Trigger, revert the Triggering mode to Soft trigger, trigger immediately 

and click on Set Trigger again. 

 

 

12. With the probe channels set up and active, the Virtual Oscilloscope now needs to be 

configured, as shown in the figure below. 
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13. Now run the scan job from ScanMaster Designer, allowing enough repetitions to give 

enough time to capture the trace in the Virtual Oscilloscope as shown in the figure 

below. 

 

  

14. Zoom into the upper left corner and note the effect shown in the figure below. 
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15. In ScanMaster Designer stop the scan job and increase the Mark Speed of the shape to 

a higher speed such as 5000 mm/s.  

Note how the error increases as the system needs to cut the corner of the geometry 

to maintain as much speed as possible as shown in the figure below. 

 

  

Note the quality settings in the figure below. We have set all the Delays to zero. 

Eventually these will be replaced in part by system parameters. Key to note here is the 

Max Radial Error is quite large at 0.1 mm. This allows ScanPack to soften the corner. 
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16. Now, let’s tighten up the Accuracy criteria to 0.001 as shown in the figure below. 

Given this tighter accuracy criteria, ScanPack will execute a repositioning trajectory 

automatically to attempt to comply with the accuracy target set. 

 

  

The behavior shown in the figure below is typical behavior of a ScanPack configured 

system. 
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Firefly3D Scan Head, User Manual, 1040–0001 Rev. 03 112 

5 OPERATING 

5.1 OPERATIONAL PROCEDURES 

Firefly3D cannot be directly controlled. 

Target audience and qualification 

Operators and experts 

Requirements 

□ You have successfully finished all necessary commissioning procedures. 

□ The laser unit, where the scan head is incorporated, complies with the standards and 

directives that are required by the declarations of incorporation of all laser unit 

components. 

Procedure 

• Control the scan head and the laser via the controlling system. 

Please find further reading in the documentation of the installed hardware and 

software components. 

5.2 OBSERVABLE SIGNALS  

Firefly3D does not provide any visual or audible means to indicate whether the product is 

operational. 
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5.3 TROUBLESHOOTING 

Target audience and qualification 

Experts 

Safety precautions 

Firefly3D does not provide any visual of audible means to indicate whether the 

product is operational. 

Firefly3D contains a high-performance beam steering system, precision optical chain 

which is designed to emit: 

▪ high power laser beams wavelength of 1070 nm at powers exceeding 1 kW 

▪ red pointing laser light at 633 nm   

During normal operation high power laser emission is expected and exposure must 

be avoided.  

 WARNING 

Visible or invisible laser radiation can cause severe retinal and corneal burns, burns 

to the skin, and may pose a fire risk. 

• DO NOT look through the exit window to view the mirrors and determine 

whether the mirrors move under command. Instead follow the procedure given 

below. 

• Switch off the laser emission. 

• Wear appropriate laser safety glasses. 

• Restrict access to the area where the alignment is done, to the persons who 

perform the adjustment and who wear appropriate laser safety glasses. 

• To avoid injury and reduce risk of fire, follow the control measures and safety 

guidelines provided by the laser’s manufacturer, and those established by your 

Laser Safety Officer (LSO), Radiation Safety Officer (RSO), or safety department 

of your business or institution. 
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The scan head contains beryllium mirrors. 

 WARNING 

Beryllium is classified as carcinogenic substance of category 1B and hazard class 

STOT RE1. This applies especially to beryllium as dust or vapor, i.e., if the beryllium 

mirrors are damaged. Beryllium causes eczema, berylliosis and cancer when getting 

in contact with skin or inhaled. 

• DO NOT open the scan head. DO NOT remove the protective windows. 

• If the housing is not sealed according to degree of protection IP65 AND if the 

beryllium mirrors are damaged, then immediately follow the response 

procedure in section 8.2 on page 127. 

 

 IMPORTANT 

DO NOT attempt to remove any covers or dissemble any part of the scan head. 

There are no user serviceable parts inside, and the warranty will be invalidated. 

Procedure 

1. Read and follow all sections within this manual, especially the steps and actions 

described within chapter 4 on page 22 ff.  

2. If Firefly3D still does not function as expected, then check the following: 

a. Check fuses and circuit breakers in any mains power supply. 

b. Check if all cables are connected correctly, especially that the PHOENIX 

CONTACT cables are correctly and fully screwed in place to ensure a good 

connection is attained.  

c. Check for any damage to cables and connections. 
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d. Check if the protective covers are removed from the main exit window on the 

base of the scanner and from monitoring ports that are in use.  

 WARNING 

Protective covers removed from unused monitoring ports can expose the 

user to laser radiation. 

• If you do not use a monitoring port, then leave the respective protective 

cover in place.  

 

e. Confirm that after the ScanMaster Controller (SMC) is powered for more than 

1 minute there are only 7 green LEDs and no red LEDs lit on the SMC, see 

Figure 48 on page 115.  

This step might not be feasible as the SMC might be incorporated in a 

machine, so the LEDs are not visible. 

 

Figure 48: 7 green LEDs if the ScanMaster Controller is powered 

f. Confirm that the SMC is powered. This is detectable using the Broadcast 

Monitor software. A screen similar to that shown in Figure 49 on page 116 

should be seen if the SMC is powered and connected correctly. 
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Figure 49: Example: Broadcast Monitor screen 

g. Often the Ethernet IP settings of the computer connected to the SMC are 

configured incorrectly. This gives the impression that Firefly3D is not 

functional. The Ethernet adapter properties shown below reflect a correct 

configuration for an SMC that is set to its default IP address of 192.168.100.20. 

  

Figure 50: Example: Ethernet properties 

3. If, after checking the points listed above no defects have been found then proceed 

with the additional diagnostic steps descried below:  
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a. Connect Firefly3D to a ScanMaster Controller (SMC) as shown in the diagram 

in section 4.3.12 on page 55.  

Note once again, the laser emission should be switched off before starting to 

undertake these diagnostic tests.  

b. If the TuneMaster II software is not already installed, then install it by following 

the procedure described in section 4.5.1 on page 78.  

c. In the TuneMaster II software, there must be 4 green LEDs lit as shown in the 

figure below.  

If this is the case, the product is ready to receive positioning commands.  

 

TuneMaster II Support Module main screen 

d. Should the TuneMaster II screen indicate any LEDs colored red or yellow then 

switch off the power to FRIEFLY 3D and contact your local Novanta 

representative for further guidance and support; see page 2. 

e. Should performance or dynamic operation be a concern, continue with the 

procedure to obtain Bode and Friction plots on page 83.  

If no issues are identified whilst working through the procedure above, functionally the 

product should be operational. However, if this guide does not address the specific issue 

experienced, please contact your local Novanta representative for further guidance and 

support; see page 2. 



 

Firefly3D Scan Head, User Manual, 1040–0001 Rev. 03 118 

6 CLEANING, MAINTAINING, AND 

REPAIRING 

Cleaning, maintaining, and repairing are limited to the procedures described in this chapter. 

If other measures become needed, please contact our customer support; see page 2. 

6.1 CLEANING 

The protective windows at the laser beam entrance and exit may require cleaning from time 

to time. The necessity for cleaning depends on how contaminated the protective windows 

are, i.e., when the work results become unacceptable. It is good practice to clean the 

protective windows only if it really is necessary, as each cleaning degrades the quality of the 

optical coating. 

Target audience and qualification 

Experts 

Safety precautions 

□  Switch off the laser unit, where the scan head is incorporated. Switch off the laser 

device, power supply, cooling and particularly disable moving parts. 
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Procedure 

The scan head contains beryllium mirrors. 

 WARNING 

Beryllium is classified as carcinogenic substance of category 1B and hazard class 

STOT RE1. This applies especially to beryllium as dust or vapor, i.e., if the beryllium 

mirrors are damaged. Beryllium causes eczema, berylliosis and cancer when getting 

in contact with skin or inhaled. 

• Clean the protective windows only from the outside. 

DO NOT open the scan head. DO NOT remove the protective windows. 

• If the housing is not sealed according to degree of protection IP65 AND if the 

beryllium mirrors are damaged, then immediately follow the response 

procedure in section 8.2 on page 127. 

6.2 MAINTAINING 

We recommend creating a maintenance plan. The maintenance intervals depend on the 

degree of contamination in the work environment. 

Table 16: Maintenance plan 

Interval Measure See section On page 

Annually • Check the laser unit and the incorporated 

scan head according to standard EN 60204.  

Check the electrical safety of all connecting 

cables and particularly the mains cable. 

– – 
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6.3 REPAIRING 

There are no user serviceable parts inside the scan head. Opening or disassembly of the scan 

head could risk your safety and safe operation of the scan head and will invalidate the 

warranty. 

Please contact our customer support team for assistance; see page 2. 
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7 DECOMMISSIONING, RETURNING, AND 

DISPOSAL 

7.1 DECOMMISSIONING  

Target audience and qualification 

Experts 

Requirements 

□  Decommission the scan head only if you want to return it, were instructed to do so, or 

if you want to dispose of it. 

Have ready 

□ Suitable screwdriver for the mounting screws 

□ Tissues or similar, to absorb leaking coolant immediately 

□ Original protective covers for the laser beam entrance and exit 

Safety precautions 

• Switch off the laser unit, where the scan head is incorporated. Switch off the laser 

device, power supply, cooling and particularly disable moving parts. 

Procedure 

 Disconnect the power supply line from the scan head. 

 Disconnect the remaining electrical lines from the scan head. 

 Turn off the coolant supply line first and then the return line. 
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 Relieve the pressure from the hose. 

 IMPORTANT 

Leaking coolant can cause a short circuit and/or damage optics. 

• Get some tissues or similar ready to absorb leaking coolant immediately. 

• Deposit the open hose tips in a way that coolant cannot leak or contain the 

coolant in a tank. 

 

 Disconnect the cooling supply lines from the scan head. 

 Dismount the scan head from the laser unit. 

 Fix the protective covers over the laser beam entrance and exit. 

If you cannot find the original protective covers then we recommend Polyamide tape. 

 IMPORTANT 

Temperatures lower than 0 °C (273 K) can cause frost damage to the cooling loop. 

 Blow-dry the scan head’s cooling loop. 

The scan head is equipped with self-sealing couplings. Therefore, it is required 

opening the coupling’s sealings. This can be done by connecting open-ended 

counterparts to the couplings. 

Blowing the cooling loop dry prevents the destruction of the self-sealing couplings 

when accidently transporting the scan head at temperatures lower than 0 °C (273 K). 

 

 Clear the scan head of contamination with any dangerous materials prior to further 

handling. 

 Dispose of the coolant according to its material safety data sheet. 

7.2 RETURNING 

This section describes how to prepare the scan head if you want to return it. 
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Target audience and qualification 

Laymen, operators, and experts 

Requirements 

□  The scan head has been decommissioned; see section 7.1 on page 121. 

□ The scan head has been cleared of contamination with any dangerous materials prior 

to return to Novanta. 

Have ready 

□ Original packaging or an equivalent packaging 

□ Parcel tape 

Procedure 

 Find the contact information for customer support, see page 2, and contact us. 

You will receive instructions about how to proceed. 

 IMPORTANT 

The scan head contains beryllium mirrors; consider section 2.4.3 on page 14. 

 

 If you are instructed to return the scan head, then package it in its original or 

equivalent packaging to prevent damage during transport. 

As memory aid use the documentation that you may have taken during unpacking. 

 Arrange for return consignment. 

7.3 DISPOSAL 

This scan head is designed to be integrated into large-scale stationary industrial tools, 

therefore 2012/19/EU (WEEE) does not apply. 

By ensuring the scan head is disposed correctly, you will help prevent potential negative 

consequences to the environment and human health, which could otherwise be caused by 
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inappropriate waste handling of the scan head. The recycling of materials will help to 

conserve natural resources. 

Target audience and qualification 

Laymen, operators, and experts 

Requirements 

□ The scan head has been decommissioned; see section 7.1 on page 121 

□ The scan head has been cleared of contamination with any dangerous materials prior 

to disposal 

Procedure 

The scan head contains beryllium mirrors. 

 WARNING 

Beryllium is classified as carcinogenic substance of category 1B and hazard class 

STOT RE1. This applies especially to beryllium as dust or vapor, i.e., if the beryllium 

mirrors are damaged. Beryllium causes eczema, berylliosis and cancer when getting 

in contact with skin or inhaled. 

• DO NOT open the scan head. DO NOT remove the protective windows. 

• If the housing is not sealed according to degree of protection IP65 AND if the 

beryllium mirrors are damaged, then immediately follow the response 

procedure in section 8.2 on page 127. 

 

• Dispose of the scan head as hazardous waste and hand it over to the applicable 

collection point or to the manufacturer as described in section 7.2 on page 122.  

For more detailed information, please contact your local city office, your disposal 

service, or our customer service; see page 2. 

 



 

Firefly3D Scan Head, User Manual, 1040–0001 Rev. 03 125 

8 APPENDIX 

8.1 INTERFACING EQUIPMENT 

The given part numbers are the manufacturer’s part numbers. 

Table 17: Required interfacing equipment 

Figure Description 

 

ScanMaster Controller 

The following part numbers are compatible with Firefly3D. Call for 

part number 

SMC-04-5-1-01-00-007  – OR – 

SMC-04-5-1-01-00-81F  – OR – 

SMC-04-5-1-01-01-007  – OR – 

SMC-04-5-1-01-01-81F 

Part number code: 

 SMC - XX - X - X - XX - XX - XXX O  

             007  SM API 

             81F  ScanMaster Designer license 

in addition to SM API 

           00    No expansion board 

           01    Expansion board 

         01    Power cable 

     5 - 1    Firefly3D connection kit 

   04    High power laser adapter 
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Figure Description 

 

Mating connector for cooling at the scan head by Rectus/Parker 

Part number 21SBK006RVX 

 

Mating connector for cooling at the laser interface adapter by 

Rectus/Parker 

Part number 20SBK006RVX 

 

PU tubing by Parker/Legris 

Outer Ø 6 mm, inner Ø 4 mm, length 25 m, color clear, max. 

pressure 12 bar (12000 hPa), max. temperature 70 °C (343 K), part 

number 1025U06R08 

 

HSSO interconnecting cable by PHOENIX CONTACT 

Length 1 m, male – male, part number 1407434; 

Length 2 m, male – male, part number 1407435; 

Length 5 m, male – male, part number 1407436; 

Length 5 m, male – unterminated, part number 1408743; 

Length 10 m, male – unterminated, part number 1408744 

 

 

Process monitoring sensor interconnecting connector by 

PHOENIX CONTACT 

Straight male connector, part number 1424662; 

Straight male data (500 kBit/s) connector, part number 1424674  

Angled male connector, part number 1424663; 

Angled male data (500 kBit/s) connector, part number 1424675 

 

GSBus interconnecting cable by PHOENIX CONTACT 

Length 5 m, part number 1402421; 

Length 10 m, part number 1402422 
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Figure Description 

 

Power supply interconnecting cable by PHOENIX CONTACT 

Length 2 m, female – unterminated, part number 1558360; 

Length 5 m, female – unterminated, part number 1558373

– Mating product for thermopile connector by binder-connector  

On website, set filter for: subminiature connector, number of 

contacts 2, lock M9, degree of protection IP67, version connector 

male angled – OR – straight 

8.2 BERYLLIUM RESPONSE PROCEDURE 

Firefly3D contains beryllium mirrors. Under normal circumstances, i.e., if the housing and 

protective windows and the beryllium mirrors are undamaged and if the product is handled 

and used properly then the beryllium mirrors present no danger. Danger may only arise if the 

beryllium mirrors are damaged and the housing is not sealed according to degree of 

protection IP65, as the damage may have produced small quantities of beryllium dust that 

may not be visible. 

Minimizing staff exposure and limiting the spread of any contamination can be achieved 

through the following simple containment procedure. 

 IMPORTANT 

• Be prepared for an incident, prepare a response pack, and have it near the product. 

This enables a smooth response. 

Response pack 

We suggest a response pack containing the following simple equipment: 

□ Wet wipes 

□ Disposable coveralls, gloves, and overshoes 
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□ Dust mask P2 (FFP3-4) 

□ Various warning signs 

□ Tape 

□ Pre-labelled heavy-duty disposal bags 

Response procedure 

 Ensure that any nearby electrical supplies are isolated. 

 Locate the response pack, see above, and have it nearby. 

 Take a wet wipe and gently lay it over the damage area without disturbing it. 

 Put on the dust mask, gloves, overshoes, and coverall. 

 Envelop the damaged part into the wet wipe and place it into the disposal bag. 

 Clean the immediate area with clean wet wipes several times, until all contamination is 

removed. Used wipes go in a second disposal bag. 

 Remove your coverall, overshoes, gloves, and dust mask and place them into the 

second disposal bag. 

 Seal both disposal bags immediately, but do not squeeze out the air. 

 Label the disposal bags as hazardous waste. 

 Wash your hands. 

 Report the incident to your health and safety officer and to your company 

management. 

 Arrange for disposal and return consignment. 

8.3 FURTHER READING 

Please find further reading in the documentation of the installed hardware and software 

components. 
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8.4 DECLARATION OF INCORPORATION 

Please turn the page. 



8 Appendix 8.4 Declaration of incorporation 

Firefly3D Scan Head, User Manual, 1040–0001 Rev. 03 130 

 



8 Appendix 8.4 Declaration of incorporation 

Firefly3D Scan Head, User Manual, 1040–0001 Rev. 03 131 

 



8 Appendix 8.4 Declaration of incorporation 

Firefly3D Scan Head, User Manual, 1040–0001 Rev. 03 132 

 



8 Appendix 8.4 Declaration of incorporation 

Firefly3D Scan Head, User Manual, 1040–0001 Rev. 03 133 



8 Appendix 8.4 Declaration of incorporation 

Firefly3D Scan Head, User Manual, 1040–0001 Rev. 03 134 

 



 

 

 

 

Novanta Corporation 

125 Middlesex Turnpike 

Bedford, MA 01730, USA 

Phone: +1-781-266-5700 

Email: Photonics@Novanta.com 

Website: www.NovantaPhotonics.com 

Firefly3D Scan Head  

User Manual 

1040–0001 Rev. 03 

© 2024, Novanta Corporation. All rights reserved. 

mailto:photonics@novanta.com
http://www.novantaphotonics.com/

	1 How to use this document
	1.1 Symbols and signal words
	Procedure

	1.2 Notation conventions
	1.3 Storage and replacement
	1.4 Specifics and structure
	1.5 Target audience and qualification
	Laymen
	Operators
	Experts


	2 General safety instructions
	2.1 Intended use
	2.2 Reasonably foreseeable misuse
	2.3 Duty of care by the customer
	2.4 Hazards
	2.4.1 Laser radiation
	2.4.2 Laser generated air contaminants
	2.4.3 Beryllium mirrors
	2.4.4 Hot laser-processed material
	2.4.5 Coolant and coolant additives
	2.4.6 Electrostatic discharge

	2.5 Modifications and spare parts
	2.6 Fire extinguisher recommendation
	Procedure


	3 Overview
	3.1 Labels
	3.2 Interfaces
	3.3 Controls and indicators

	4 Preparing for use
	4.1 Transporting and storing
	Target audience and qualification
	Requirements
	Procedure

	4.2 Unpacking and verifying the scope of delivery
	Target audience and qualification
	Have ready
	Procedure

	4.3 Installing
	4.3.1 Incorporating the scan head into the laser unit
	Target audience and qualification
	Have ready
	Requirements
	Safety precautions
	Procedure
	Specifics of the interface

	4.3.2 Connecting the cooling
	Target audience and qualification
	Have ready
	Requirements
	Procedure
	Specifics of the interface

	4.3.3 Connecting the high-speed serial output
	Target audience and qualification
	Have ready
	Procedure
	Specifics of the interface

	4.3.4 Connecting process monitoring sensors
	Target audience and qualification
	Have ready
	Procedure
	Specifics of the interface

	4.3.5 Connecting a GSBus based controller
	Target audience and qualification
	Requirements
	Have ready
	Procedure
	Specifics of the interface

	4.3.6 Connecting power
	Target audience and qualification
	Requirements
	Have ready
	Procedure
	Specifics of the interface

	4.3.7 Recommended wiring and grounding scheme
	Technical advisories

	4.3.8 Connecting a fiber laser
	Target audience and qualification
	Requirements
	Have ready
	Safety precautions
	Procedure

	4.3.9 Connecting the thermopile (optional)
	Target audience and qualification
	Have ready
	Procedure
	Specifics of the interface

	4.3.10 Connecting to optical sensors and vision cameras
	Target audience and qualification
	Procedure
	Specifics of the interface

	4.3.11 Diagnostics connector
	Target audience and qualification
	Have ready
	Procedure
	Specifics of the interface

	4.3.12 Connecting a laser to ScanMaster Controller
	Target audience and qualification
	Procedure

	4.3.13 Installing the software
	Target audience and qualification
	Procedure


	4.4 Commissioning
	4.4.1 Switching on for the first time
	Target audience and qualification
	Requirements
	Procedure

	4.4.2 Setting the device configuration
	Target audience and qualification
	Requirements
	Procedure

	4.4.3 Calibrating the scan field
	Target audience and qualification
	Requirements
	Procedure

	4.4.4 Importing measurement data into the Calibration Wizard
	Target audience and qualification
	Procedure


	4.5 Diagnostics and tools to optimize the scanning process
	4.5.1 Using the ScanMaster Controller as a host
	Target audience and qualification
	Procedure
	Procedure to obtain a Bode Plot or Friction Plot

	4.5.2 Reading configuration information
	Target audience and qualification
	Procedure

	4.5.3 Configuring TuneMaster II – Support Module to observe scanning trajectories
	Target audience and qualification
	Procedure


	4.6 Tutorial: Tune mode switching
	4.6.1 Requirements
	4.6.2 Check the tune mode
	Target audience and qualification
	Procedure

	4.6.3 Exploring Traditional / Vector tune mode behavior
	Target audience and qualification
	Procedure

	4.6.4 Switching to ScanPack tune mode
	Target audience and qualification
	Procedure

	4.6.5 Exploring ScanPack tune mode behavior
	Target audience and qualification
	Procedure



	5 Operating
	5.1 Operational procedures
	Target audience and qualification
	Requirements
	Procedure

	5.2 Observable signals
	5.3 Troubleshooting
	Target audience and qualification
	Safety precautions
	Procedure


	6 Cleaning, maintaining, and repairing
	6.1 Cleaning
	Target audience and qualification
	Safety precautions
	Procedure

	6.2 Maintaining
	6.3 Repairing

	7 Decommissioning, returning, and disposal
	7.1 Decommissioning
	Target audience and qualification
	Requirements
	Have ready
	Safety precautions
	Procedure

	7.2 Returning
	Target audience and qualification
	Requirements
	Have ready
	Procedure

	7.3 Disposal
	Target audience and qualification
	Requirements
	Procedure


	8 Appendix
	8.1 Interfacing equipment
	8.2 Beryllium response procedure
	Response pack
	Response procedure

	8.3 Further reading
	8.4 Declaration of incorporation


